CIVIL ENGINEERING
ELEMENTAL COST ANALYSIS
(CEECA)

KAEDAH MEMASUKKAN DATA KE DALAM
SISTEM MELALUI PWCIC

Civil Engineering Elemental Cost Analysis



Dua (2) workflow;

I- Data originated from ATDA
Module

- Historical Data (CEECA Only)

Dua (2) sub workflow;
I- Dari Pejabat ‘HODT’
II- Dari Pejabat 'S.O.’



System Log In

url — pwcic.jkr.gov.my
user log in

2 SYSTEM LOGIN
2.3 USER LOGIN

Registered user may login from portal front page. Click on “LOGIN’ menu bar.

2.2 LOGIN PAGE
User Login
ol form fislds are reqguired
E-fMaii :
1}

Password:

Recset password

Sign in new account @

@ Submit Cancel

Civil Engineering Elemental Cost Analysis
(CEECA)



Siti Nor Diyana o

(7))| MENU ||PROFILE | LOGOUT

Once login is successful, user name will appear on top of login bar.
Click on "MEMNU" to enter project menu.

Administration

ekt att al

Portal

®

1 [Siti Nor Diyana]
E:
- N
e ¥ u
.- ‘
Buid-Up Rale ATDA CEECAACDA E-Mail

®

®

@

Back to portal page.

Open build-up rate project.

Open ATDA,CEECA,ACDA project.
System internal notification email.
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3.2

PONO (P

PROJECT INFORMATION

B XpPaic =

& @ bokot pa Vpage 30t

Creste New Projed. 3

MEMSINA JALAN DARI LENCONGAR BANAT SURGAL
1 PETANIL MELALUI PEXAN SEMELING XE PENAN

B DALRAM KUALA MUDA, KEDAH DARUL

AMAR

ol o P aE & N
Catagory— (v|  —Type— v ~ Sl v Fikes

Category Roie TR FEELA, s

avi -0 /L =

1) L Zitw Chemrwnce HOOT,HODT,HOOT HOPT Bkt 20°03°20:
7 UAT 270314 CEECA OMLY v 20-03- B
1) ARC LT 270413 CEECA OMLY HOOT PFublehed 26-03-
3 UAT ATDA 28032014 aviL 27-03 4 E
1) UaT &TDY THODTHOOT dpprowed Fublshed Publehed 27-03-
4 dusanvy avi 0104014 S =
N HOOTHODTHOOT HOPT Edt 01-040014
dd HODTHODT,HOOT Sutemitted 01-04f 2014
n)bb HOOT,HOOTHOOT HOPT Gkt 05-0§-3014
5 texting avi 24-08-2014 -
1y testng 1 HOOTHODT,HOOT HOOT Edt 26- (- 2014
% recheck atde scgo osecs whow oviL 0a-ps-2014 £ S v /
P f _—
1 3.2.2
Project Information Menu.
Project Information Title. Created At

Button to create new project.
Page Navigation Menu.
Project Filtering Menu.

Project/Contract Information.

Edit project information.

26-03-2014

Open project(contract) details (ATDA,CEECA,ACDA).

Civil Engineering Elemental Cost Analysis

(CEECA)

Create New Project

Create New Project

To create new project click on “Create New Project’ button.

| Project

Siate




323 Edit Existing Project
To edit existing project, click on project edit icon |

Project ®

Projact Title
MEMBINA TALAN DART LENCONGAN BARAT SLMGAT PETANT MELALUT PEKAN SEMELING KE PEKAN BEDONG,

Clint
Kemergenan Kemaiuan Luar Bandar dan wilavah ¥
Work Category Froject Category Freparaton Type
CIVIL - SELECT -~ v ATDA, CEECAACDA
Srate City
Ferak |v| Ipon
— 3.2.6 Project/Contract Information

& @ @ @
No Project/Contract Title Categoryillole {ATDA CEECA  ACDA Created At [ Actio:]

#MEMBINA JALAN DART
Update Projec: Cancel LENCONGAN BARAT
SUNGAIL PETANI

To execute update process, click on button “Update Project Eﬂﬁmﬁb%fﬁ'ém
. . . 1) Land Site Clearence HODT,HODT,HODT HOPT Edit 26-03-2014
324  Delete Existing Project Action
- 2 UAT Z703THCEECA cvIL 26-03-2014 [ [
When office contact person login inta the system, 1 —O ONLY
delete icon will appear for the project deletion. [} ABC UAT 270413 HODT published 26-03-2014
Only an empty project can be deleted by office contact person. CEECA-ONLY
This rules is also applied to project contract deletion. AE 3 UAT ATDA 28032014  CIVIL 27-03-2014 A |5
i) UAT ATDA HODT, HODT, HODT aApproved Published Published 27-03-2014
1.  Project Title highlighted in bold text.
2.  Contract Title highlighted in normal text.
- 3.  Project category - ‘BUILDING’ or ‘CIVIL'.
E d It/ D e I ete 4.  Your office role for current contract.
5. Show contract work flow status.
Work Flow Status:
1.HOPT Edit, 2.User Edit, 3.Submitted, 4.Approved, 5.Published.
6. Project or contract created date.
7.  Project Action:
Click on icon </ to edit project information.
Click on icon =l to open project contract details.
Civil Engineering Elemental Cost Analysis 6
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To edit contract information, click onicon =/ , new prompt will appear as below:

Ceneral Informaation o

—General Informaton

Contract Tele Contract Titke 2

3.3.1.4 Add New Contract

”: Cantract Descrigtion
. Add Cortract
To add new contract, click on button el

Parkage No
Project Details x
e = - L
Contract Title Sl
Contract Title 2 -
Terrain / Gesgraphical Condrion
Crezte Detail Cancel —Contractar Information
Contractar for Main Warks
From the pop-up windows, enter *Contract Title’ and click on button “Create Detail”.
Newly added contract will appear in list of Contract Title as below. Chintracte Clas | Sradel v
Contract Perod i ¥
—Tender Informatian
L

Basis of Tender

Add Contract ,

Diate Tender Clozed

EL

Tnder Valdiey Periad [in :|=1r:]

Tender Valdicy Dete

Updatz Cancal

Enter all the required information and click on button “Update” to save the changes.

Civil Engineering Elemental Cost Analysis
(CEECA)



Workflow #1 — Data Originated from
ATDA Module

Create Project -> Create Contract -> ATDA Data -> ATDA
Complete -> CEECA Assignment -> CEECA Data

Workflow #2 — Historical Data (CEECA Only)

Create Project -> Create Contract -> CEECA Assignment
-> CEECA Data

Civil Engineering Elemental Cost Analysis
(CEECA)



Pejabat terlibat;

- HODT

-  Perunding (sekiranya perlu)
- S.0.

Iiv-  Unit Kos (CKUB)



Users Access

3341

Verifier should have
access to edit ALL fields
befors verfication

Flow of CEECA

CONSULTANT |

unrkos |

(Note : If Consultant
assigned, they will work
concurrently with SO,

Both get access)

Data Entry (if applicable)

Submit
acknowledzement to S0

Note : Consultant has
access same as 50.)

s0 |
Form Assignment; |
I- Consultant (if applicable)

ii-Verdier [in SO Dffice) |
|

Data z:my |

|

Review before sending
to verifier (ALL FIELDS)

\

Button;

Save - check, amend,
save and print hardcopy
Verify - A date shall
capture this task auto-
generated)

CEECA Only : Creation of project will be done by HODT and HODT must fill in until General
Information and do assignment to SO

Access Lavel

50 can edn all fiedds i tabs "Project Detalis', "Source of Materials',
'Final Re-measurement of Project Cost’ & 'Specification’
Consultant can edit same as above

HODT can edit same as above, if it opts to do the CEECA tasks on its own

Civil Engineering Elemental Cost Analysis

(CEECA)

Note 1 : 5O can only
start with CEECA & the
assignment (get the
access) once HODT do
the assgnment in the
ATDA

Note 2:If the HODT
tendsto do CEECA task
own Its own, it will select
verfier (from its office)
and automatically
assignment for SO
disabled

Button;

Publish - okeywith the
data and publish to
portal

Revert - Not oksy with
data, will revert 1o

owner (SO}

10



33.4.2 CEECA Email Notification

Notification =

1 Assignment from HODT
2 Assignment by SO
Userin SO

3 Consultant submit back to SO

4 SO submit to Verifier (S0)
5 Verification by verifier (SO)
6 Publication by Unit Kos

7 Reversion by UnitKos

Civil Engineering Elemental Cost Analysis

(CEECA)

(cc)

(e€)

{cc)

Notification to;
SO {Contact Person)
HODT (Contact Person)

Notification to;
Cansultant

SO (Verifier)

SO (Contact Parson)

Notification to;
SO (Contact Person)

Notification to;
SO (verifier)
SO (Contact Person)

Notification to;
SO (Contact Person)
Unit Kos [Contact Person)

Notification to;
Unit Kos [Contact Person)
SO (Contact Person)

Notification to;
SO (Contact Person)
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3.3.431 Open CEECA Data

PROJECT TITLE : Jalan Mulom & Lnau dan Mukim 7 Se

No Contract Title c'e::e" Info ATDA Rev CEECA ACDA
04-08- ‘
1 Jalan Mukim 6 Linau dan Mukim 7 2014 = 5 + 1

R Create CEECA

Once ATDA task has been approved and published, CEECA task is ready to be proceeded.
Click on CEECA work flow status number to open CEECA data task.

e CEECA Task
Assignment

Office :BKJ, CKUB

Office: -Sekd- v

Venfier 1

Usar: -Seked- v

Consultant

Omce ;- Salatt - v Pemon Inchame - Selact— ¥

CEECA contract.

Selected contract title.

Data Navigation Menu Bar:
Work Flow Submission Button.

Bw NP

Civil Engineering Elemental Cost Analysis
(CEECA)



3.3.434 Project Details

Project Element & Cost Briel Spedficat]

. =
/r’f‘ CEECARCAD — <
[ Approval Inforration

Date !

1 Contract Information i

Contract Number :|

o — | Project Details

B | 4 Additional information

Compietion Date |

Technical Information | @

No. of Berms (Highest Skope) [C
Overal Road Length
Road Length (Nett)

e Data from Project Details &
e " Contract Information will be

Median Width |[0.00 m

A . carried to FORM 1 of CEECA
’\\\\ 0. mes v

1. Click on ‘Project Details” menu bar.
2.  Key-inand select all the required fields of project details ( Contract Information &

Technical Information. Approval information will be filled by system once approved. )
3.  Click on button ‘SAVE’ to save the changes.

Civil Engineering Elemental Cost Analysis 13
(CEECA)



& Status

Project Element & Cost

SRR MAIN BACK EMAIL LOGOUT [Far
FO2 Ka Pularek, Kola Tinggl, Jehor |Reka dan Bina)
Costof P

Work flow submission button will appear on the left side of page navigation menu.
Depending on user login level and access type, it will appear or disappear. Following table
show work flow status number and login access level where where the submission button

will take place.
Work Status Access Button
Flow Description Group Appearance
Status
Mumber
1 Waiting 50 user or Consultant | A. 50 user Submit For Verification
to complete the task. B. Consultant Acknowledge Work Done |
2 Waiting 50 user to complete S0 user Submit For Verification
the task and submit for
verification.
3 Waiting SO verifier to verify 50 verifier Approve this CEECA |
and approve the task.
a4 Waiting Unit Cost to approve Unit Kos Publish I or Reject |
for publishing.
5 Work task has been published.
Login by SO office

WORK FLOW STATUS: 1. HOPT 2.

FROJECT TITLE : Jalan Mukim & Linau dan Mukim T 52

Mo Contract Title Created At
1 Jalan Mukim 6 Unau dan Mukim 7 £ 04']?28__02]? 14

MENU BACK EMAIL

Civil Engineering Elemental Cost Analysis

Info

2

(CEECA)

LOGOUT [Syahiran

ATDA Rev CEECA ACDA

Status Bar

14



Source of Materials

3.3.4.35 Source Of Material

®

Source Of Material

Setting / Assignment Project Details

Project Element & Cost

1 Sand & Crusher run 0.[?:]! kmn from site
2  Asphakic Concrete Binder Course & Asphaltic Concrete I CI._D_EIJ km from site
3  Imported Earth

0.00| km from site

A

Click on “Source Of Material’ menu bar.

Key-in all required data. New item description subject to Unit Kos approval,
User may request to system administrator to register.
3. Click on button ‘SAVE' to save the changes.

Civil Engineering Elemental Cost Analysis

(CEECA) 15



33436  Project Element & Cost
Contract Cost MAIN BACK EMAIL LOGOUT [Syasran|

CONTRALT TITLE  Jakn Nubam & Linsu dan Mk T Ssrntiong, Satu Pahal, Jobhor

Tldak perlu dlmasukkan Seklranya S ! Assignment Projoct Details Source Of Matenal || Progect Element & Cost | | Brief Specificatior View Repor
guna Workflow ATDA

Perlu diisi sekiranya guna

Workflow CEECA Only T

fa GENERAL ITEMS 1.434700.00 0.00 000 | 1.434700.00

2 MAINWORKS
2a m%b\mce AND DEMOLITION 76.720.00 0.00 0.00 76.720.00
2b  EARTHAORKS 1,846.955.00 9,00 000 | 1.846.956.00
2 DRAINAGE WORKS 52463100 0.00 000 | 32483100
20 PAVEMENT WORKS 3,698,814 60 0.00 000 | 389831450
277.000.00 .00 000 | 277.00000
6,568,340 50 0.00 000 | 656834050
1.278.455.70 0.00 000 | 127845870
1,556 500,00 0.00 000 | 1.959,90000
19932900 0.00 0.00 199,329.00
NE § 520.000.00 0.00 000 | 52000000
THERS 161 150,00 0.00 0.00 161,150.00
(W% () 181 15000 Qo J.(N) 161,150 0
3 PRIMECOST SUM & PROVISIONAL SUM 857 250,00 0.00 857.250.00
TOTAL 16,402 245 80 k 000/ 16,402.246.00

Element & Cost

Data will be carried to
2. To change the record value, double click on the numbers, key-in and press
FORM 2, 3, 5 of CEECA enter key to update.

1. Click on ‘Project Element & Cost” menu bar.

0.00

3. Click on ‘STRUCTURES' to add new, edit & deletion of structure data.

4. Click on ‘OTHERS’ to add new, edit & deletion of others data.

Civil Engineering Elemental Cost Analysis

(CEECA) 16



334361 Structures

(o] ket Structure

To add new structure, click on ‘STRUCTURES' link as above.

Mew Struchire Data %
e __F
Struchure Name :
Structure Specification = |Tvpe and Sz of fl, Type of Structurs and atc
Typa of Biling - i Dimersion Length : [0.0 |
Typa of Structure : X Dirmensien Width : 0.0
Mo, of spansz | M " Total Length of File : [0.0
Temporary Werks | 0.00 0,00 0.00 0.00 2g B BES 0.00
Filing | 0.00 0.00 0.00 0.00 e
9h | TRAEEIF MANACREMENT & COMTEOI 1 9RG QNN AN
Substructre | 0.00 0.00 0.00 0.00
Superstruciure | i s i 000 To edit structure data, click on structure data as above.
Select and key-in all required data, click on button ‘SAVE' to update.
Pavement | 0.00 0.00 0.00 000
Total 000 .00 0.00 000

*1 adocation of Previsanal Sum [temst'r?m Orlginal Contract 53?[

EE i - el Pirieelam

CLOsE

From new pop-up window, select and key-in all required data.

For field ‘Structure Specification’, key-in data will be listed at ‘Brief Specification’

menu (item 3.3.4.3.7).

Field ‘Type of Pilling', “Type of Structure’ and ‘No. Of Spans’ are compulsory to be selected.
Click on button ‘SAVE' to save new structure data.

Civil Engineering Elemental Cost Analysis

(CEECA) L



Others

33.43.6.2  Others ( Main Works )

| OTHERS (MAIN WORKS)
| |l| — select — ' 0.00) 0.00/ 0.00|
1 OSHA 161,150.00 000 0.00 151,150.00 lTjT P
TOTAL 161,160.00 0.00 0.00 161,150.00

*1 Allocation of Provislonal Sum Items from Original Contract Cost
*2 Adjustment Due to Remeasurement of Final Quantities (Additicn/ Omission)

(
CLOSE

Clickon | to add new data, select and key-in required data, click on H to save.
Clickon /I to edit existing data, select and change required data, click on E tosave.
clickon [ to delete existing record, click on ‘YES’ from the confirmation window.

Civil Engineering Elemental Cost Analysis
(CEECA)
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Brief Specification

Data will be carried to FORM 5 of CEECA

3.3.4.3.7 Brief Specification

1.

2.

SITE CLEARANCE AND DEMOLITION WORKS
EARTHWORKS

DRAINAGE WORKS

PAVEMENT WORKS

ROAD FURMITURE

GEOTECHNICAL WORKS

STRUCTURES

TRAFFIC MANAGEMENT & CONTROL
ENVIRONMENTAL PROTECTION WORKS
ROLITINE MAINTENANCE WORKS
OTHERS

] OSHA

Click on ‘Brief Specification’ menu bar.

To enter or edit specification description, double click on highlighted row,
key-in and press enter key to update.

Specification for site clearance]

Civil Engineering Elemental Cost Analysis
(CEECA)



CEECA Report

33438 View Report

t Element & Cost Brief Specification | View Report

User can view report at any time in pdf format, click on ‘View Report’ menu bar
to view the report. It depends on the browser type, the report may open in
different view tab or automatically downloaded to the PC.

CIVIL ENGINEERING ELEMENTAL COST ANALYSIS - FORM 1

PROJECT COST ANALYSIS
SO8 TIFLE ~ecwch wom viow [DIE14
LOCATEON ] CLEMT: Kansnisrian Fenddilan
GEMERAL PROJECT INFORMATION
Exiec] Oenly are Sie Cononon
Frojecs Brw Deacrigos [T
Froject Calsgory:
JHE Damign Sarcad "=
Twrrwin | Geoprapinicwl Condies. Vel
M. ol Barrra (Highesd Soce} Tne
vl Nomi LangE SO0 T
Foms Langis {MmET 490 ke
Chodcer Widh Im0m Twvom of Shouider Farvec
Mscimn ‘Wi 150m Typs of Mecn P
M of e (-] Typs of carrmgawwy Zdare cusl cETEgEWEY
Mz of Srcurs 1
Conkedl gkl Aomaimaol of Comirect Som
Caortmd Wo | pbafrijird Diiginml Conirmct Sum @ MM 51000, 00000
St o T e e
Ty =l Corfruct: Carrmntions| - Lol Fdpwind Cortmd Sum : RN S8 58D 00000
Fom of Cortrec PN 00,
Contwct Perioct 30 osthe ot Cecywoms © =S54 40,000 00
Dt of Tarder o120
Commancarss Dute e W Do ©  10H %
Compmbon Duis [ Criginall [ EE T

Tl Sand & Cromr s

U b o e

¥} Amphaftc Corcrsie Binder Courss & Sapralc Corcrsls Wesring Coorse 90000 ko roe mile

o) e parts L

SOUT ke froe e

Civil Engineering Elemental Cost Analysis
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CEECA Analysis

« CEECA Report
* Road Analysis
« Structure Analysis



